
 

 

  

 A Simple Microsoft Access 
Application for Capturing 
Metadata on Geological Reports 
held by the Afghan Geological 
Survey 

 International Business Development Programme 

Commercial Report CR/06/179N 

 

 

  



  



  BRITISH GEOLOGICAL SURVEY 

INTERNATIONAL BUSINESS DEVELOPMENT PROGRAMME 

COMMERCIAL REPORT CR/06/179N 

  

The National Grid and other 
Ordnance Survey data are used 
with the permission of the 
Controller of Her Majesty’s 
Stationery Office. 
Ordnance Survey licence number 
Licence No:100017897/2005.   

Keywords 

Report; metadata; application; 
languages; Microsoft Access; 
Afghan Geological Survey. 

Front cover 

Two Afghan Geological Survey 
staff using the metadata capture 
application in the AGS building, 
Kabul, under the direction of the 
author. 

Bibliographical reference 

MCCORMICK, T. 2008.  A Simple 
Microsoft Access Application for 
Capturing Metadata on 
Geological Reports held by the 
Afghan Geological Survey. 
British Geological Survey 
Commercial Report, 
CR/06/179N.  29pp. 

Copyright in materials derived 
from the British Geological 
Survey’s work is owned by the 
Natural Environment Research 
Council (NERC) and/or the 
authority that commissioned the 
work. You may not copy or adapt 
this publication without first 
obtaining permission.  
Contact the BGS Intellectual 
Property Rights Section, British 
Geological Survey, Keyworth,  
e-mail ipr@bgs.ac.uk You may 
quote extracts of a reasonable 
length without prior permission, 
provided a full acknowledgement 
is given of the source of the 
extract. 

A Simple Microsoft Access 
Application for Capturing 
Metadata on Geological Reports 
held by the Afghan Geological 
Survey 

T McCormick 

Contributor/editor 

AC MacKenzie 

 

 

© NERC 2008. All rights reserved Keyworth, Nottingham   British Geological Survey   2008 



The full range of Survey publications is available from the BGS 
Sales Desks at Nottingham, Edinburgh and London; see contact 
details below or shop online at  www.geologyshop.com 

The London Information Office also maintains a reference 
collection of BGS publications including maps for consultation. 

The Survey publishes an annual catalogue of its maps and other 
publications; this catalogue is available from any of the BGS Sales 
Desks. 

The British Geological Survey carries out the geological survey of 
Great Britain and Northern Ireland (the latter as an agency service 
for the government of Northern Ireland), and of the surrounding 
continental shelf, as well as its basic research projects. It also 
undertakes programmes of British technical aid in geology in 
developing countries as arranged by the Department for 
International Development and other agencies. 

The British Geological Survey is a component body of the Natural 
Environment Research Council. 

 

British Geological Survey offices 
 
Keyworth, Nottingham NG12 5GG 
 0115-936 3241 Fax 0115-936 3488 
e-mail: sales@bgs.ac.uk 
www.bgs.ac.uk 
Shop online at:  www.geologyshop.com 

Murchison House, West Mains Road, Edinburgh EH9 3LA 
 0131-667 1000 Fax 0131-668 2683 
e-mail: scotsales@bgs.ac.uk 

London Information Office at the Natural History Museum (Earth 
Galleries), Exhibition Road, South Kensington, London SW7 2DE 
 020-7589 4090 Fax 020-7584 8270 
 020-7942 5344/45 email: bgslondon@bgs.ac.uk 

Forde House, Park Five Business Centre, Harrier Way, Sowton, 
Exeter, Devon EX2 7HU 
 01392-445271 Fax 01392-445371 

Geological Survey of Northern Ireland, Colby House, Stranmillis 
Court, Belfast, BT9 5BF 
 028-9038 8462 Fax 028-9038 8461 

Maclean Building, Crowmarsh Gifford, Wallingford, Oxfordshire 
OX10 8BB 
 01491-838800 Fax 01491-692345 

Sophia House, 28 Cathedral Road, Cardiff, CF11 9LJ 
 029–2066 0147 Fax 029–2066 0159 

Parent Body 

Natural Environment Research Council, Polaris House, 
North Star Avenue, Swindon, Wiltshire SN2 1EU 
 01793-411500 Fax 01793-411501 
www.nerc.ac.uk 

 

BRITISH GEOLOGICAL SURVEY 



CR/06/179N; Final 1  Last modified: 2008/12/15 15:10 

i 

Foreword 
This report describes a Microsoft Access ™ application developed by the author whilst working on the BGS 
International Commercial Project “Afghanistan Institutional Strengthening”.  This application has been used with 
great success to capture metadata about the geological reports and other documents held by the Afghan Geological 
Survey. 
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Summary 
This report describes a Microsoft Access ™ application that was developed by the author and used during the course 
of the BGS International Commercial project “Afghanistan Institutional Strengthening”, 2004-2007.  The purpose of 
this application is to provide a method for staff of the Afghanistan Geological Survey (AGS) to record simple 
metadata describing the documents held by that organisation.  Requirements for this application included the ability 
to record titles and authors’ names in several languages.  It was necessary that the application be simple enough to 
be used by people with very limited knowledge of computers, and whose first language is not English. 

The metadata recorded using this application were subsequently harvested, validated, and used to populate a web 
database of metadata describing the reports and other documents held by the AGS.  This database is available for 
search on the AGS website at http://www.bgs.ac.uk/AfghanMinerals/ (October 2008). 

http://www.bgs.ac.uk/AfghanMinerals/�
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In this report, Section 1 describes the context of this work and explains why this application was necessary.  The 
formal requirements of the application are also set out.  Section 2 describes the database, or “back-end”, part of the 
application.  Section 3 describes the user interface, or “front-end”, part of the application.  In Section 4, the 
workflow that was developed for recording the metadata is described.  Some concluding remarks are given in 
Section 5.  The guide that the author prepared for users of the application is presented as an appendix.  A glossary, 
tables and figures complete the report. 
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1 Introduction 
One of the deliverables from the BGS International Commercial project “Afghanistan Institutional Strengthening” is 
an online database of metadata describing the paper documents held by the Afghanistan Geological Survey (AGS).  
There are about 2500 of these documents, stored in an archive in the AGS headquarters in Kabul.  Some of these are 
internal documents written by AGS staff.  Some are copies of reports relating to Afghan geology or the AGS itself 
produced by other organisations and lodged with the AGS.  There are also copies of publications produced by other 
organisations.  Most are written in Russian and/or Dari, one of the two official languages of Afghanistan (the other 
being Pashto).  There are a few in other languages: German, Italian, French, and English are represented.  Taken 
together, the reports cover the whole spectrum of survey activities, from geophysical and mapping surveys to 
financial administration (Figure 1). 

The online database stores a range of metadata describing these documents, including title (in both English and Dari, 
as well as the native language of the report if this is different, for example Russian), authors’ names, year of 
authorship, storage location, and descriptions of included items such as maps, cross sections and graphic logs.  The 
database also maintains links to digital copies of key documents.  It is possible to query this database on the AGS 
website at http://www.bgs.ac.uk/AfghanMinerals. 

It was decided by the project archivist RP McIntosh and the author that initially, inventory numbers, titles, authors’ 
names and year of authorship would be recorded to build a “first pass” database.  Collection of additional metadata, 
such as numbers of parts and pages and descriptions of included maps and other items, would be left to a later 
“second pass” possibly to be carried out entirely by Afghan staff.  This is not dealt with in this report. 

BGS staff and sub-contractors were able to record and translate titles and authors’ names in several languages 
including English, Russian, French, German, and Italian.  However it was clear from the outset that the project 
would rely on Afghan staff to type metadata in Dari, and translate it into English.  To facilitate this, the author 
developed a simple software application, using Microsoft Access, which AGS staff could use to key in metadata in 
whichever language was required.  This application stored the metadata on a networked file server, from where it 
could subsequently be collected, validated, and used to populate the final online database. 

Training Afghan counterparts in the use of this application, and in accurate keying of metadata, helped to further one 
of the main aims of the project, which is to transfer skills to AGS staff. 

1.1 THE TASK 

The task faced by the project team and their Afghan counterparts was to assign a unique inventory number to each 
document in the archive, and to record its title, year of authorship, and the names of the authors.  Title and authors’ 
names were to be recorded in both English and Dari.  In addition, where the language of the document was not 
English or Dari, title and authors’ names were to be recorded in the original language for bibliographical 
completeness. 

Project sub-contractors Peter Kovac, Igor Rojkovic and Rasto Vojtko from Slovakia were able to provide English 
translations of titles and authors for the documents written in Russian, and other team members were able to 
translate from other European languages.  However all keying, and translation to and from, Dari had to be done by 
AGS counterparts. 

One aspect that made development of this application an interesting proposition was that Russian is typed using the 
Cyrillic alphabet, while Dari uses the Farsi (Persian) alphabet and is typed from right-to-left.  The metadata capture 
strategy needed to take account of these facts. 

1.2 FORMAL REQUIREMENTS 

The requirements for the metadata capture application may be formally stated as follows: 

1) It must be possible to store an inventory number, a title, names of one or more authors, year of authorship, and 
additional comments for each document. 

2) It must be possible to input the title in Dari, English, and if necessary in some other language (the native 
language of the document) at the same time. 

3) It must be possible to input the authors’ names using the Farsi, English, and (if necessary) Cyrillic alphabets at 
the same time. 

4) It must be possible for several users to use the application at the same time on different computers, but the data 
should be stored on a file server so that all users have access to the same data.  The application must manage 

http://www.bgs.ac.uk/AfghanMinerals�
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conflicts that arise, for example, as the result of more than one user attempting to edit the same record at the 
same time. 

5) The application must be simple to learn and use, so that people with very limited computer experience and/or 
English proficiency can use it. 

6) The application must be robust enough to continue to operate correctly when the BGS staff who are able to 
maintain it are not present in Afghanistan. 

1.3 THE IT ARCHITECTURE 

BGS have installed a number of networked Dell PCs running the Microsoft Windows XP ™ operating system, and a 
networked file server running the Microsoft Windows Server 2003 ™ operating system in the AGS building.  This 
makes it possible to run client-server applications that consist of a “back-end” database application residing on the 
file server, communicating with a “front-end” or “client” user interface application that may be installed on several 
networked PCs (Figure 2).  The advantage of this approach over using entirely separate applications installed on 
each PC is that the same data are available to any PC where the client software is installed.  Appropriate file access 
privileges can be set for the users on the file server, enabling them to work with the data but preventing them from 
accidentally deleting the database! 

2 The Database Application 

2.1 DATABASE 

The purpose of the database application is to store the metadata in a secure location where it is available to each of 
the client user interface applications (Figure 2).  There is only one copy of this file, installed on the networked file 
server.  Because the purpose of this file is just to store data, it has no forms or other user interface components.  It 
just contains the tables necessary to store the metadata. 

For each document, the application needs to be able to store an inventory number, year of authorship, title (in 
English, Dari and, if necessary, a third language), comments (in English and Dari), authors’ names (using the 
English, Farsi and, if necessary, Cyrillic alphabets), and the language(s) the report was written in.  For each 
document, there is only one inventory number, year of authorship, title, and comment (although the title and 
comments are expressed in more than one language).  However, for each document, there may be one or more than 
one authors, and one or more than one language.  For example there are many reports written in both Russian and 
Dari.  A simple data model was developed to meet these requirements.  It is shown in Figure 3.  It consists of three 
tables: 

1) REPORT: This holds one record for each document, and stores the inventory number, year of authorship, title, 
and comments. 

2) REPORT_AUTHOR: This stores the names of the authors of a document.  There may be none, one, or more than 
one author for a given document.  REPORT_AUTHOR has a foreign key relationship with REPORT, the join 
being made through the shared inventory_number column. 

3) REPORT_LANGUAGE: This stores the languages for a document.  There may be one or more than one language 
for a given document.  REPORT_LANGUAGE has a foreign key relationship with REPORT, the join being made 
through the shared inventory_number column. 

The tables and their columns are described in detail in tables 1-3. 

For purposes of this simple application, the identity of the user who entered each record is not recorded.  This was 
not considered necessary, because this is not a production database application, just a tool for collecting metadata.  
However, the date and time at which each record is entered is recorded automatically as the record is inserted.  
There are two reasons for this.  First, it allows for a simple check on the progress of the counterparts in inputting 
metadata.  Second, in the case of REPORT_AUTHOR and REPORT_LANGUAGE, recording the date and time of data 
entry ensures that, for a given document, author names and languages can be reported in the order in which they 
were typed in.  This is particularly important for authors’ names because their quoted order is significant. 

2.2 DATA VALIDATION AND RECORD LOCKING 

Because the purpose of this application is simply to gather metadata, which will then go through a validation process 
before being imported into the web database that is the ultimate goal of this activity, this application provides very 
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little in the way of data validation apart from forcing the user to enter the correct metadata into the correct fields.  
Inventory number is constrained to be an integer.  Names of languages are constrained by the select list built into the 
metadata entry form in the client user interface application (Section 3). 

In order to prevent conflicts arising through more than one user attempting to edit the same record at the same time, 
record-level locking is used.  This means that when one user begins to edit a record, all other users are prevented 
from editing the same record until the first user has finished and saved it. 

2.3 LOCATION AND PERMISSIONS 

The back-end database file is called “Report Data Input 14_02_2005_be”, and is installed on the AGS networked 
file server BGSAFS003 at the following location: Archive\WorkingFiles\Data\. 

General AGS users have “Read & Execute”, “List Folder Contents” and “Read” permissions in this folder. 

3 The Client Application 

3.1 OVERVIEW 

The purpose of the client is to provide the interface that users use to enter and edit metadata.  It provides the 
following functionality: 

1) A form for navigating, typing and editing metadata. 

2) Table views of the metadata. 

3) The ability to generate a report presenting metadata describing one or more AGS documents. 

These options are accessed via menus. 

3.2 APPLICATION STRUCTURE 

The components that make up the client application are listed in Figure 4.  They include queries, forms and sub 
forms, a report, a menu bar with menus, and a toolbar. 

3.2.1 Queries 

The heart of the application is three queries that provide the link between the client application and the back end 
database.  These queries are: 

1) REPORT_Q1: Retrieves all records and fields from the table REPORT in the database and sorts them by 
inventory_number. 

2) REPORT_AUTHOR_Q1: Retrieves all records and fields from the table REPORT_AUTHOR and sorts them by 
inventory_number, then by date_entered.  This ensures that the authors for a given document are 
shown in the same order in which they were typed.  This is necessary for bibliographical purposes. 

3) REPORT_LANGUAGE_Q1: Retrieves all records and fields from the table REPORT_LANGUAGE and sorts them 
by inventory_number, then by date_entered.  This ensures that the languages for a given document 
are shown in the same order in which they were typed. 

The forms and report that display the metadata use these three queries as their data source.  In addition, when 
metadata are inserted, edited or deleted, the operation is performed through these queries. 

3.2.2 Forms 

The application uses three main forms, one of which uses two sub-forms in its construction.  The forms and sub-
forms are: 

1) FrmREPORT_Q1 (caption: “Enter Data”): This is the main data entry and editing form.  Its data source is the 
query REPORT_Q1.  The form has buttons for record navigation and data entry and editing operations.  
FrmREPORT_Q1 uses within its construction two sub-forms: 
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i. SubfrmREPORT_AUTHOR_Q1 (no caption): This is a component on frmREPORT_Q1 that lists the authors 
of the currently selected document.  Its data source is the query REPORT_AUTHOR_Q1. 

ii. SubfrmREPORT_LANGUAGE_Q1 (no caption): This is a component on frmREPORT_Q1 that lists the 
languages of the currently selected document.  Its data source is the query REPORT_LANGUAGE_Q1. 

2) FrmRptREPORT_Q1 (caption: “Select Reports”): This is a modal form that allows the user to specify what 
range of document inventory numbers they want to appear on a generated report.  It does not display data so it 
has no data source. 

3) FrmAbout (caption: “About”): This is a modal form displaying brief information about the application, 
including the email address of the developer.  It has no data source. 

Use of these forms is described in Section 3.3 “Application Operation”. 

3.2.3 Report 

The application includes one report, rptREPORT_Q1 (caption: “List of Reports”).  This displays metadata from the 
database as a formatted report.  This report can be printed out from the default printer by clicking on the associated 
“Print” button that appears at the same time as the report.  More information on how to generate the report is given 
in Section 3.3 “Application Operation”. 

3.2.4 Menus and Toolbars 

The menu bar is called reportDataEntry, and it holds four menus: 

1) File

i. 

: This menu has options for generating a printable report, and for exiting from the application.  The menu 
items are: 

Make Report

ii. 

: This causes the form frmRptREPORT_Q1 to be displayed.  The user uses this form to select 
the range of document inventory numbers they want to appear on a report, and then run the report (see 
“Application Operation” below). 

Exit

2) 

: Exits the application. 

Edit

i. 

:  A standard edit menu, with the following menu items: 

Cut

ii. 

: Cuts any selected text and places it on the clipboard. 

Copy

iii. 

: Copies any selected text to the clipboard. 

Paste

iv. 

: Pastes text from the clipboard to the I-bar position. 

Find

3) 

: Causes the “Find and Replace” dialogue box to open.  The user can use this to search for a specific 
record in the database. 

Tables

i. 

: This menu allows the user to see “table-views” of the metadata: 

Reports

ii. 

: Runs the query REPORT_Q1 and displays the results as a table. 

Report Authors

iii. 

: Runs the query REPORT_AUTHOR_Q1 and displays the results as a table. 

Report Languages

The application uses one tool bar, called agsReport.  It is this tool bar that appears and holds the “Print” button 
when a report is generated (see Section 3.3 “Application Operation”). 

: Runs the query REPORT_LANGUAGE_Q1 and displays the results as a table. 

3.3 APPLICATION OPERATION 

3.3.1 Entering and Editing Metadata 

When the application is launched, the main data entry and editing form, frmREPORT_Q1, appears.  This form is 
used for most of the time when using the application, and is shown in Figure 5. 

To enter a new record, click the >* button to navigate to a new (blank) record, and then enter metadata in the fields: 

1) Inventory Number *: This is the unique inventory number of the document.  This field can only take 
a number.  This field is mandatory.  Its data source is REPORT_Q1.inventory_number. 

2) Year *: The year the document was compiled.  This field is mandatory.  Its data source is 
REPORT_Q1.year. 
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3) Title in Dari: The title of the document, written in Dari.  This field is optional.  Its data source is 
REPORT_Q1.title_dari. 

4) Title in English: The title of the document, written in English.  This field is optional.  Its data 
source is REPORT_Q1.title_english. 

5) Title in other language: This field is optional.  If the document was written in some language 
other than English or Dari, the title is entered here, in the original language.  Its data source is 
REPORT_Q1.title_other. 

6) Author Name, Dari; Author Name, English; Author Name, Russian: The names of 
the authors are listed here.  It is possible to enter the names of more than one author, by adding them onto 
the bottom of the list.  No matter what language the document was written in, each author name should be 
recorded in both Dari and English.  Where the document was written in Russian, “Author Name, Russian” 
is also used for the name in the Russian Cyrillic alphabet.  The data sources for these three fields are 
REPORT_AUTHOR_Q1.author_name_dari, author_name_english, and 
author_name_russian respectively. 

7) Language: The language(s) the document was written in is recorded here, by selecting a language from 
the select list.  It is possible to enter more than one language, by adding new entries onto the bottom of the 
list.  The data source for language is REPORT_LANGUAGE_Q1.language. 

8) Comments in Dari; Comments in English: Additional comments about the document may be 
entered here.  Comments should be recorded in both Dari and English.  These are optional fields.  Their 
data sources are REPORTS_Q1.comments_dari and comments_english respectively. 

Clicking the √ button at top right of the form saves the current record to the back-end database.  Navigating away 
from the record also causes it to be saved. 

To navigate to a particular record, use the |< (first record), < (previous record), > (next record), and >| (last record), 
buttons to move between records.  The form presents records in order by Inventory Number.  You can also select 
“Find” on the “Edit” menu.  This opens the “Find and Replace” dialogue box (Figure 6), which can be used to 
search for a particular record. 

You can edit an existing record by making the necessary changes, and either clicking the √ button to save the record, 
or just navigating away from the record.  Note that it is not possible to change the inventory number once it has been 
entered. 

The “!” button causes the client application to re-query the back-end database.  This has the effect of refreshing the 
data in the form.  This is useful when two or more users are using the application simultaneously.  If one user enters 
a new record, another user at another computer cannot “see” the new record until they re-query the database. 

As well as seeing metadata one record-at-a-time on the form, it is also possible to see many records at once.  
Selecting “Reports” from the “Tables” menu causes the contents of the REPORT table to be displayed in table view, 
with the records sorted by Inventory Number (Figure 7).  This is achieved by running the query REPORT_Q1 and 
displaying the results, as described in “Application Structure” above.  Selecting “Report Authors” or “Report 
Languages” from the Tables menu causes table views of author’s names and report languages to appear in a similar 
way. 

3.3.2 Generating and Printing a Report 

Selecting the “Make Report” option on the “File” menu causes the “Select Reports” dialogue box to open (Figure 8).  
Select the Inventory Number of the document you wish the report to begin at from the first select list, and the 
Inventory Number you wish the report to stop at from the second select list, then click “OK”.  A report similar to 
that shown in Figure 9 appears.  Note the print button at top left.  Clicking on this button causes the report to be 
printed out at the default printer. 

3.3.3 Getting Help 

Selecting “About” from the “Help” menu causes the information box shown in Figure 10 to appear.  This box shows 
the name and contact email address of the developer.  There is also a hyperlink, “AGS Reports Data Input 
Help.doc”.  Clicking on this causes a user guide to be displayed.  For this to happen it is necessary that the guide, 
AGS Reports Data Input.doc, is located in the same directory where the client application is installed on 
the client PC.  This user guide is included as Appendix 1 in this report. 



CR/06/179N; Final 1  Last modified: 2008/12/15 15:10 

6 

3.4 CATERING FOR DIFFERENT INPUT LANGUAGES 

It is necessary for the application to accept and store metadata in English, Dari and Russian.  Russian uses the 
Cyrillic alphabet.  Dari uses the Farsi (Persian) alphabet and is read from right-to-left.  Microsoft Access is able to 
store Unicode characters, so storing the metadata proved to be no problem. 

This left the problem of keying the metadata into the application.  In order to type using the Cyrillic and Farsi 
alphabets in Microsoft Windows XP, it is necessary to set up Russian and Farsi as “Input Languages”.  This is done 
through the “Regional and Language Options” setting on the Windows XP control panel.  In addition, to type in 
Farsi you must install right-to-left language support, also done through “Regional and Language Options”.  Once 
these languages are installed, it is possible to switch between input languages by selecting the correct language from 
the language select list on the Windows Task Bar (Figure 11). 

The project had access to a limited number of Russian language computer keyboards, which could be used to type in 
Russian.  We also found the Microsoft “On-Screen Keyboard” to be a very useful tool.  This can be used to “type” 
by clicking the keys on screen with the mouse pointer.  The keys shown by the on-screen keyboard are appropriate 
to the currently-selected input language (Figure 12).  This tool enables the user to type using a language for which 
they do not have a keyboard.  The on-screen keyboard is found in Windows XP under the Start Menu at Start -> All 
Programs -> Accessories -> Accessibility -> On-Screen Keyboard. 

4 Workflow for Metadata Capture 
Capture of metadata using this application began in late February of 2005.  Three counterparts were provided by 
AGS to be trained in this work.  One of these had some computer experience, having worked with PCs in a Kabul 
construction company.  The other two had no previous computing experience.  It was necessary therefore to begin 
by providing a basic introduction to computing, and then training in the use of the application. 

The AGS documents themselves are stored in two offices on the fourth floor of the AGS building.  There is no 
network cabling or computers in these offices.  The metadata capture was carried out in an office on the third floor, 
using three networked PCs. 

The AGS librarian in charge of the document collections signed out documents to the counterparts in lots of around 
20 at a time, keeping a record in a loans book.  The documents were then processed in the third floor office.  After 
keying of the metadata, the documents were returned to the fourth floor and signed back in. 

Work proceeded very slowly at first because of the counterparts’ unfamiliarity with the nature of the work and the 
technology being used.  However they speeded up as they gained confidence. 

By the time of writing, basic metadata on all approx. 2500 documents is available in English and Dari and in the 
original language (usually Russian) through the efforts of our Afghan counterparts and our Slovak sub-contractors.  
This includes about 350 documents whose sole language is Dari; our Afghan counterparts, and this application, were 
invaluable for processing these, as neither we nor our sub-contractors were able to translate, nor even type, Dari. 

5 Concluding Remarks 
In the course of this work, a methodology was developed for capturing metadata in multiple languages, using a 
simple Microsoft Access application.  This methodology is not just applicable to the present work, but can be 
adapted for use in similar situations in other settings and countries. 

Local counterparts were trained in the use of the application for metadata capture.  The robustness and simplicity of 
operation of this application is demonstrated by the fact that the Afghan counterparts were able to continue to use it 
while the author was not present in country. 

The metadata captured using this application subsequently formed the heart of the web database of AGS documents 
now searchable online at http://www.bgs.ac.uk/AfghanMinerals/ (October 2008). 

http://www.bgs.ac.uk/AfghanMinerals/�
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Appendix 1 The User Guide Provided to Afghanistan 
Geological Survey Staff 

 

INSTRUCTIONS FOR INPUT OF DATA ON AFGHANISTAN GEOLOGICAL SURVEY 
REPORTS 

 
Tim McCormick 

British Geological Survey 
22 February 2005 

 
 
1.  Start the Reports Data Input application by clicking twice on the icon:  
 

 
 

2.  If you want to use the On-Screen Keyboard, start it by clicking twice on its icon: 
 

 
 

(If there is no On-Screen Keyboard icon, you can open the On-Screen Keyboard by 
clicking on Start  All Programs  Accessories  Accessibility  On-Screen 
Keyboard.) 
 
The On-Screen Keyboard looks like this: 
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3.  The Reports Data Input screen looks like this: 
 

 
 

a)  Menus 
There are 4 menus at the top of the screen:  
 

 
 

File: 
Make Report: Click this to make a printed list of reports. 
Exit:  Closes the application. 
 
Edit: 
Cut:  Cuts the selected text. 
Copy:  Copies the selected text. 
Paste:  Pastes the cut or copied text at the position of the I-bar. 
Find: Opens the “Find and Replace” box.  This allows you to search for a 

word or number in the database. 
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Tables: 
Reports:   Opens the list of reports in table view. 
Report Authors:  Opens the list of authors in table view. 
Report Languages: Opens the list of languages in table view. 
 
Help: 
About: Opens a form that gives information about this application. 

 
b)  Buttons 
There are 7 buttons at the top right of the “Enter Data” form: 
 

 
 

 : re-queries the database (that is, it recalls the data from the database) 
 

 : goes to the first record 
 

 : goes to the record before this one 
 

 : goes to the record after this one (or a new blank record if you are already at 
the last one) 
 

 : goes to the last record 
 

 : makes a new blank record 
 

 : saves the current record 
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C)  Fields 
The fields to type data into are: 
 
Inventory Number * 
This is the number written in pencil on the bottom right of the label on the front cover of 
the report.  This field MUST be entered. 
 
Year * 
The year the report was compiled.  This field MUST be entered. 
 
Title in Dari 
This is the title of the report, in Dari. 
 
Title in English 
This is the title of the report, in English. 
 
Title in other language 
If there is also a title on the report in some other language, for example Russian or 
German, type it here. 
 
Author Name, Dari 
List the names of the authors, in Dari alphabet. 
 
Author Name, English 
List the names of the authors, in English alphabet. 
 
Author Name, Russian 
If the report is written in Russian, list the names of the authors using Russian alphabet 
here. 
 
Language 
Select the language the report is written in from the list: 
 

 
 

If the report is written in more than 1 language, list the languages like this: 
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Comments in Dari 
If there is any extra information that is helpful about the report, type it here in Dari.  For 
example, if there is more than 1 copy of the report, say that here. 
 
Comments in English 
These are the same as the comments in Dari, but in English. 
 
 
4.  To make a printed list of reports, click “Make report” on the “File” menu.  This box 
appears: 
 

 
 

Select the report number to start at and stop at.  In the example here, the list will start at 
report number 1580 and stop at report number 1650.  Then click “OK”. 
 
When the report appears, it looks like this: 
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While the report is open, there is also a print button at the top left of the screen, which 
looks like this: 
 

 
 
Click on this button to print out the report. 
 
 
5.  In case of problems, click “About” on the “Help” menu.  This box appears: 
 

 
 

This gives Tim McCormick’s email address at BGS.  It also has the words: AGS Reports 
Data Input Help.doc.  If you click on this, this document opens. 
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Glossary 
Data Model An abstract model defining the collection of tables, fields and relationships that 

makes up a relational database. 

Field / column A single location in a record holding an item of data used to describe one 
attribute of the subject of the database.  For example, the REPORT data table 
has fields for inventory_number, year, title_dari, 
title_english, comments_dari, comments_english, etc.  
When a table is displayed, the fields form columns in the table. 

Foreign key When a relationship is made between two tables, it is normal to relate the 
primary key field in one table to a field in the related table.  The field in the 
related table is known as the “foreign key”. 

Form A graphical user interface component that provides a “user-friendly” view of 
the data in a database, with the aim of making data entry faster, easier and more 
accurate. 

Often forms include “subforms”, another form embedded in the main form for a 
specific purpose. 

A modal form is one that remains in the foreground until some user-input is 
made. 

Graphical User Interface 
Component 

An object on the screen that the user interacts with to perform some operation.  
They include forms, menus, buttons, select lists, and other components. 

Menu A graphical user interface component providing a list of options (“menu 
items”) that allows the user to control the operation of the application.  For 
example, this application has “File”, “Edit”, “Tables” and “Help” menus. 

The menus are arranged along the “menu bar” which appears at the top of the 
screen. 

Primary key The primary key is one or more fields whose values are unique for each record 
in a table.  The primary key allows the database management software to 
uniquely identify each record in a table. 

Query A set of instructions that retrieves data matching specified criteria from a 
database.   

Record / row A collection of fields that represents the data for a single entry in a data table.  
When a table is displayed, the records form rows in the table. 

Report A graphical user interface component that is used to display data retrieved from 
a database formatted in a way suitable for printing out on paper. 

Table A data structure in a digital database that stores data in the form of fields and 
records. 

Toolbar A graphical user interface component that holds buttons which the user can 
click on to perform an operation.  For example, when a report is generated by 
this application, a toolbar also appears holding a print button that is clicked to 
print the report out. 
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Tables 
 

Table 1 Design of the REPORT table. 

Column Name Column Design Description 
INVENTORY_NUMBER Primary Key 

Long Integer 
Required 

Inventory number.  This must be unique for every 
document. 

YEAR Text (10) 
Required 

Year the document was compiled.  Uses the 
Western calendar. 

TITLE_DARI Memo 
Optional 

Title of the report, in Dari. 

TITLE_ENGLISH Memo 
Optional 

Title of the report, in English. 

TITLE_OTHER Memo 
Optional 

Title of the report in its original language, if that 
was not English or Dari. 

COMMENTS_DARI Memo 
Optional 

Comments about the entry, in Dari. 

COMMENTS_ENGLISH Memo 
Optional 

Comments about the entry, in English. 

DATE_ENTERED Date/Time 
Required 
Default = Now() 

Date/time of data entry.  Populated automatically 
on data entry, using the Visual Basic Now() 
function. 

 

Table 2 Design of the REPORT_AUTHOR table. 

Column Name Column Design Description 
INVENTORY_NUMBER Long Integer 

Required 
Indexed (duplicates 
OK) 

Inventory number.  Foreign key to 
REPORT.inventory_number. 

AUTHOR_NAME_DARI Text (50) 
Optional 

Author's name, using Dari alphabet. 

AUTHOR_NAME_ENGLISH Text (50) 
Optional 

Author's name, using English alphabet. 

AUTHOR_NAME_RUSSIAN Text (50) 
Optional 

Author's name, using Russian alphabet. 

DATE_ENTERED Date/Time 
Required 
Default = Now() 

Date/time of data entry.  Populated automatically 
on data entry, using the Visual Basic Now() 
function. 

 

 



CR/06/179N; Final 1  Last modified: 2008/12/15 15:10 

15 

Table 3 Design of the REPORT_LANGUAGE table. 

Column Name Column Design Description 
INVENTORY_NUMBER Primary Key 1 

Long Integer 
Required 

Inventory number.  Foreign key to 
REPORT.inventory_number. 

LANGUAGE Primary Key 2 
Text (10) 
Required 

Language. 

DATE_ENTERED Date/Time 
Required 
 

Date/time of data entry.  Populated automatically 
on data entry, using the Visual Basic Now() 
function. 
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Figures 

 

Figure 1 A typical example of the documents held by the Afghanistan Geological Survey.  This one is a geological 
report written in Dari and has a number of graphical annexes. 
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Figure 2 The IT architecture within which the MS Access application operates.  The data are stored by the database 
application, which runs on a networked file server.  This database is communicated with using the “front-end” or 
“client” application, copies of which are installed on several PCs within the AGS building. 

 

 

Figure 3 Data model for the application.  The database has three tables: REPORT, REPORT_AUTHOR, and 
REPORT_LANGUAGE.  There is a 1-to-many relationship between REPORT and REPORT_AUTHOR (because each 
document can have more than one author, while each author must be the author of a document).  There is a 1-to-
many relationship between REPORT and REPORT_LANGUAGE (because each document can be written in more 
than one language, while each language must be the language of a document). 
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Queries
REPORT_Q1
REPORT_AUTHOR_Q1
REPORT_LANGUAGE_Q1

Application

Forms
frmREPORT_Q1 “Enter Data”

subfrmREPORT_AUTHOR_Q1
subfrmREPORT_LANGUAGE_Q1

frmRptREPORT_Q1 “Select Reports”
frmAbout “About”

Reports
rptREPORT_Q1 “List of Reports”

Menu Bars
reportDataEntry

File

Edit

Tables

Help

Make Report
Exit

Cut
Copy
Paste
Find

Reports
Report Authors
Report Languages

About
Tool Bars

agsReport
Print

 

Figure 4 The components comprising the client application.  Each of the components is described in detail in the 
text. 

 



CR/06/179N; Final 1  Last modified: 2008/12/15 15:10 

19 

 

Figure 5 The main data entry and editing form, frmREPORT_Q1.  This is displayed when the application launches. 

 

 

Figure 6 The "Find and Replace" dialogue box.  Selecting “Find” on the “Edit” menu causes this to be displayed. 
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Figure 7 The result of selecting “Reports”, and “Report Authors” from the “Tables” menu.  Table views of the 
documents and authors data are displayed. 

 

 

Figure 8 The "Select Reports" dialogue box, frmRptREPORT_Q1.  Selecting "Make Report" from the "File" menu 
causes this to be displayed. 
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Figure 9 A report.  Clicking "OK" on the "Select Reports" dialogue box causes this to be displayed.  Note the 
toolbar with a "Print" button above the report.  Clicking the "Print" button causes the report to be printed out at the 
default printer. 

 

 

Figure 10 The "About" form, which shows the name and email address of the developer.  It also has a hyperlink that 
opens the user guide presented in Appendix 1. 
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Figure 11 The language toolbar.  To input data using one of the languages select it from the list. 

 

 

Figure 12 The Microsoft Windows on-screen keyboard.  Two instances of the keyboard are shown: the upper one 
has the input language set to Farsi, the lower one has the input language set to Russian. 
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